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Installation

LGROW version 2.03 is designed to work under windows 95 or above operating systems. If you have already installed a previous version of LGROW you should uninstall it using the Add/Remove Programs facility in the Windows setting screen before you install this new version.

Run setup.exe from within Windows. Follow the on screen instructions to successfully install LGROW. On some systems you may encounter apparent error messages about lack of disk space or an inability to register certain files. These can safely be ignored - press the 'Ignore' button and continue with the installation. 

We are continually trying to improve LGROW and current versions for downloading can be found at

http://www.mlwin.com/hgpersonal/lgrow 

If you have any technical problems which the web site cannot handle please send them to Dr H. Pan (h.pan@ich.ucl.ac.uk ). 

Using LGROW

Longitudinal growth norms

Current cross-sectional growth charts are used to assess the growth of children by comparing their growth with population percentile norms (or standards) for their age and gender. Growth measurements, when plotted on such a chart, allow us to judge how typical those measurements are at a particular age.

Very often, however, a sequence of measurements is available and we would like to use these efficiently to judge the typicality of the growth pattern. Calculating longitudinal norms is just what LGROW is designed to do. 

LGROW uses the most recent (final occasion) measurement together with any combination of previous (earlier occasion) measurements to compute and display the conditional Z scores and percentiles and also, if required, the average velocity and acceleration percentiles. Conditional standards are generally more sensitive than velocity or acceleration standards; they compute the Z scores or percentiles given the particular chosen combination of previous measurements. They can be produced for height given previous heights, and for weight given any combination of current and previous heights and previous weights. LGROW can utilise a set of measurements made across varying time intervals, thus overcoming the limitations of existing growth velocity standards which require fixed 1-year intervals.

The reference sample upon which LGROW is based is taken from a set of British and French longitudinal studies (see Appendix). It also uses the current British reference standards (Freeman et al., 1995) so that users can make basic cross sectional comparisons and for other populations this needs to be borne in mind. For the purposes of longitudinal judgements, however, it is anticipated that LGROW will prove satisfactory across a wide range of populations. Future releases  of LGROW  will allow users to import their own cross-sectional or longitudinal standards where these are available.         

At young ages supine length may be measured instead of height. LGROW makes no distinction between these two measurements and they have been treated as equivalent in the data sets used to construct the norms. Where both measurements are made on a single individual the user may wish to make a correction to the supine length, derived from replicated measurements, or, for example, by adding a constant; the value of 1.0 cm is sometimes recommended.

LGROW release 2.0 can utilise longitudinal measurements from 3 months to 18 years for boys and 3 months to 16 years for girls. Some minor restrictions apply for height and for weight for height norms. These occur for boys with a measurement between 16 and 18 years and for girls with a measurement between 15 and 16 years. In these cases previous measurements are only allowed to extend back to 14 years for boys and 12 years for girls. In certain cases care is needed when using results that extend from before the age of 14 years to after the age of 16 years for boys, and from before the age of 12 years to after the age of 15 years for girls.  Appendix C discusses the issues associated with this. Measurements can be referred to the British cross-sectional reference standards for the age range from birth to 23 years.

Pan and Goldstein (1997) give a full description of the methodology. A less technical introduction to the use of conditional norms is given by Cameron (1980).

Using the software

The software has been designed as a series of menus and displays intended to be intuitively clear. The data entry table is where a sequence of ages, heights and weights can be entered or a file opened. This remains as a source, which can be saved for later use. From this a series of selections of measurements can be made by clicking individual ages or measurements or sets of these. A choice of norm (e.g. velocity or conditional) is made and the result is displayed in a second table, which contains the estimated percentiles and ‘z’ scores. Multiple selections can be made and a series of results can be built up. Finally, these results can be displayed on a chart so, for example, a sequential set of percentile values can be plotted from successive sets of values for an individual. Graphs are also available for displaying the cross-sectional data. 

There is a help system within the software, which can be accessed at any time. It gives details of how to import and export data, edit it, calculate and plot norms. It also provides some basic statistical background and references to more detailed expositions.

In the following sections we describe how the software operates using some example growth data. 

Entering data

In this section we look at how to enter new measurements into LGROW. We shall describe everything you need to know about entering measurement data. We shall also describe how to obtain Z scores and percentiles, using the example data sets supplied with LGROW.
When LGROW is opened up you will see the following menu bar 
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Typing in new measurements

Click on File then New to open up the following blank data entry table
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Use this screen to enter data; each screen caters for a single child. Each row of this table corresponds to a measurement occasion.

Entering an ID number.  

Clicking on the ID button brings up the following screen
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You can check which individuals are already present (if any) by clicking on the ID list box. To enter a new ID number:

1. Enter the number in the ID to add box and click the Add ID button

2. Click the ID list box to choose the new number you have added from the list

3. Click the Select ID  button

Note: if data for an existing individual are being displayed LGROW will prompt you to save the data before presenting you with a new blank data entry screen.

LGROW allows up to 50 occasions per individual and 200 individuals in a single data file.

Entering Gender

1. Click on the Gender button and choose Male/Female from the selection offered. 

2. Click OK and the chosen gender will be displayed

Entering Date of Birth (optional)

1. Click the Date of Birth button

2. Enter the date in the displayed box in the format day/month/year as shown and click OK.

The date of birth will be displayed in the Date of Birth box. 

Note that you will need the date of birth if you wish to enter or display dates of measurements.

Entering ages or dates of measurement

By default LGROW displays the data entry table with Age as the first entry column. If a date of birth has been entered and you wish to enter measurement dates rather than ages click the Age/Date button to switch between these two modes of entry format.

Date entry mode

1. To enter the date of measurement, after switching to this mode using the Age/Date button, click in the date cell of the next unused occasion.

2. If you now press the backspace key today's date will be entered automatically. If you wish to type a different date you can either edit today's date by positioning the cursor and using the backspace or delete keys, or enter the date directly in the box at the top of the date column followed by the return key or the right arrow key.

Age entry mode

3. To enter the age, when in this mode, click in the age cell of the next unused occasion and type the age in decimal years. 

4. When you have finished press return to move to the next occasion or the right arrow on the keyboard to move into the next cell to the right. Note that all four keyboard arrows can be used for moving around the table.

At any time you can press the Age/Date button to switch between the different views.

Entering Height and Weight

1. Click in either the height (in cm) or weight (in kg) column for the desired occasion and type in the measurement. 

2. After entering a height measurement you may use the right arrow  key to move to the next cell to the right to enter the weight. Pressing the return  key moves down to the next occasion.

3. If either height or weight are unavailable for an occasion, leave the corresponding cell blank

Note that when you have completed the entry of a measurement the corresponding Z and P values are automatically computed and entered into the table.

If you wish to delete a cell you can use the Delete cell button, and if you wish to delete an entire occasion you can use the Delete row button. 

When you have finished entering an individual's data you can click on the ID button to enter data for a new individual. Once you have entered all your individuals you may save the complete file, and this is described in the next section. 

We will use some example data to illustrate how LGROW is used to calculate individual norms. First we describe how to import and save data files.

Importing and saving data files

System files

LGROW saves and retrieves files in a special worksheet or 'System file' format. 

1. Click on File then Open and you will see the following screen which by default displays the worksheet files in the LGROW program directory.
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The file names shown above are supplied with LGROW for demonstration purposes. Two of them are used in this manual for illustration but they may all be deleted later if required.

2. Select the file 'Sample1.lgr', click on Open  and the following screen will appear. Note the default suffix 'lgr' for system files.
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We see that a date of birth has been entered, although by default LGROW displays the age. To display dates of measurement

3.     Click on the Age/Date button to give
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and we can now enter measurements for a further occasion, for example using the backspace key to enter the present date.

Saving a file is similar to importing one. To save our data as a system file 

1. click on File then Save as to bring up the dialogue box such as the one below 

2. select the *.lgr extension.
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3. Type in a new file name or leave the existing one and click save.

Note that you may also export data to an ASCII file. If you click on text files in the save as type box you will be presented with a choice of formats as described in the following section.

Importing text files

We can import data from an ASCII text file by clicking on Import  in the File menu and selecting *.txt or *.* file extensions. 

1. Select the example file 'sample1.txt'. You will be presented with the File type screen below. 
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2. Since the data for this individual are actually stored as the first file type, that is in the order  'ID', 'gender', 'age', 'height', 'weight', we can simply import them by clicking on OK. 

3. If we have data in an order not described on this screen, then we can define the variables by clicking on Other type which will display the following  screen:
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4. Click on the drop down menu variable list to give the following selections:
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5. Highlight the name describing the first variable in your file (here ID) and it will be inserted in the box. 

6. Click on the first box under the Data variables list and then on Insert name. This will place the name into the data variables list. You can continue to do this, so defining the structure of your data set, and finally clicking on OK to read in the file.

When you save text files you will be presented with a similar set of screens.

Plotting cross-sectional norms for height and weight

To plot your measurements on the current cross sectional British growth norms (Freeman et al., 1995) click on the Graph button. To select values double click on the appropriate cells, or double click at the top of the column to select all the measurements in the column. To plot the height data in sample1.lgr
1. Click on File then Open and select sample1.lgr. Click Open to read in the data

2. Double click at the top of the Height column to select the column and you will see the asterisks appearing as on the following screen
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Note: If your system uses the comma (,) symbol as the decimal symbol you should change the example data files so that the full-stop/period symbol (.) is changed to a comma. This can be done in any text editor or word processor since all LGROW data files are just text files. You can change the symbol in the 'regional settings' section of the Windows control panel.
3. Click on the Graph button to give the following:
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The default, as displayed above, is equal S.D. spacing which results in the actual displayed percentiles listed at the right. 

The spacing and number can be changed as follows:

1. Click on Percentiles  in the Options menu to obtain the following display which applies to the above plot
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You may change the number or spacing in this dialogue box and the graph will be updated accordingly.

To obtain a plot in terms of specified percentiles 

1. Click on Percentiles with unequal SD spacing to obtain the following percentiles dialogue box
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2. Click OK to produce the following plot
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The chosen (default) percentiles, the 3rd, 10th, 25th, 75th, 90th, 97th , are listed on the right hand side. You may add or remove the percentiles plotted in the percentiles dialogue box.

To obtain a plot of Z values we carry out a similar procedure. Thus, for height

1. Double click at the top of the Z(height) column to select all the values in this column

2. Click on Graph to obtain the following
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Any of the graph windows can be enlarged by dragging at a corner or clicking the 'enlarge' icon at the top right of the screen. For information on copying and printing graphs and windows see the next section. 

Copying and printing windows

Any window can be copied to the clipboard by clicking Edit then Copy window. This facility will copy any window to the clipboard for pasting into another application such as a word processor. The data and graph windows displayed in this manual have been prepared in this way.

You may also copy a graph alone, without any window labelling simply by clicking on the graph. This pastes a higher quality image to the clipboard. When pasting this into another application, such as WORD or EXCEL, if you are given a choice you should paste as a plain 'Picture' rather than a Windows metafile.

LGROW does not have a facility for directly printing windows. To do this you will need to copy the window to the clipboard and paste into another application as described above. If your application allows  you may then edit the picture before printing it or incorporating it in a document.

Age range for graphs

You may specify your own age range for the graphs in order to display just the range for your data.  The allowable range is from 0 to 23 years. Click on the Options menu and then on Age range for graphs. Enter the lower age limit in the From box and the upper age limit in the To box, then click OK. This will apply to all the graphs you produce. You may need to adjust the range in order to ensure that the scale markings are integer ages. The default is to display the range from birth to 20 years.

Conditional and longitudinal norms using multiple measurements

There are two ways to produce conditional norms based upon multiple measurements. We may compute norms for weight given height at the same occasion, or we may compute longitudinal norms- the main innovation introduced by LGROW.

1. Click on Norms to bring up the following options:
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Height conditional on previous heights

The first option allows you to select a final outcome or response height and a series of predictors. 

1. Click on this option to see the following screen which allows you to select the heights you require (the original data screen will still be visible)
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2. Click on the response or outcome height in the raw data table, say the second one, 145.90

3. Click on the height cell in the Response table. 

Select the first predictor height as follows

4. Click on the  required height, say the first one 140.0

5. Click on the first height cell in the Predictors table

You will now see the following table
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The maximum number of predictors is 3. You may delete individual selected cells or all the entries using the Delete cell or  Delete all buttons. To change the response simply select another and click it into the response cell.

6. When you have finished click on Run to display the results table 
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The right hand side of this window is divided into three components. 

· Conditional

· Velocity

· Acceleration

Each of these gives the Z score and corresponding percentile for the final occasion measurement given the earlier measurement: the conditional norm for height given previous height. The average acceleration is only available when two or more previous heights are selected.

Every height conditional on previous height

Let us now add the second and third height measurements.

1. Close down the Results window by clicking on the x at the top right

2. Click on Norms and select Every height on previous height
You will obtain the following window
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3. Click run to give
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To plot graphs we may double click on the values we wish to plot, or double click at the top of a column to select all values. If we select a column for the first time and single click at the top and then click on Graph, we will obtain a graph with no data plotted. 

Plotting conditional norms

1. Select both of the conditional Z values and then click on Graph to obtain 
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In this way we can continue to plot successive values for the conditional norms, or their corresponding percentiles, as well as for velocities or accelerations. 

The remaining options under Norms allow you to compute a variety of conditional, velocity and acceleration norms copying individual measurements into the selections window. Thus, suppose you wish to choose a particular combination of predictors for weight not listed on this menu explicitly. 

Weight on selected weight and height

1. Choose the third option in the Norms menu Weight on selected weight and height
2. Assuming you require the final weight (51.90) as response, click on the cell containing it and then click the weight cell in the Response box.

3. Select the current height (150.10), click in the first Height box under Predictors
4. Select the previous two weights into the next two predictor occasions to give
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The maximum number of predictor measurements in LGROW is 3.  For example, you may have current weight on current height and two previous weights as above, or, say, current weight on current height, previous height and previous weight. Experience suggests that there is no benefit from using more than three predictor measurements.

5. Click Run to give the following table of results
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Long term longitudinal data

The example we have been using contains only three measurements. Often many more measurements are available and LGROW can provide a detailed picture of changes in growth. To illustrate this we look at the second example data set

1. Click on Open then File (OK to overwrite data) and Sample2.lgr then Open
2. Click on Norms and select Every height on previous two heights
3. Click Run
4. In the Results window you will see the following display - you will need to resize the window by dragging the top or bottom borders, in order to display all the rows of the table.
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Note that because we included the previous two heights the accelerations are given. Note also that you can select and delete individual occasions (using the Delete row option). 

5. Select the Conditional Z by double clicking at the top of the column and then click Graph to obtain the following plot

[image: image30.png]SD scores

Age (years)





This shows the child's change in growth as measured by the conditional norms, starting at the population average but then decreasing over time.

Maintaining and editing a database

Clicking on the ID button in the data entry table brings up the following screen; note that the existing database already has three individuals.
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This allows you to remove or add sets of data for individuals. To add a set of data you should type a new identification number into the box and then click Add. To enter data click on the arrow by the ID list and then the identification number you just typed in. Then click Select ID and you will be given a blank worksheet to complete. You can also, of course, select an existing individual using their identification and you can remove a selected ID or remove all IDs. 

When you wish to save a database, choose File then Save as and enter the filename into the dialogue box. It is recommended that you do not attempt to overwrite an existing file, but maintain one or two old backup versions of a database and delete old versions as appropriate.
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Appendix A: data sources

The data have been assembled from the studies, identified by their geographical origin, given in the following tables for boys and girls.

	Table 1. Boys

	Dataset
	 Sample size
	No occasions 
measurements
	Age range (yr)
	Measures

	Chard
	 107
	   829
	8.30 - 16.51
	HT       WT

	Cambridge (1)
	 132
	 2464
	0.04 -  6.07
	SL        WT

	Cambridge (2)
	   93
	   214
	4.94 - 11.09
	HT        WT

	Edinburgh
	 103
	 3645
	0.00 - 22.74
	SL  HT  WT

	Eastbourne
	   64
	   402
	0.00 -   2.07
	SL

	Harpenden
	 445
	 5088
	1.01 - 35.08
	HT        WT

	ICC 
	   89
	 1870
	0.00 - 22.11
	SL  HT

	France
	 257
	 4008
	0.08 - 20.00
	SL  HT

	Total
	1290
	18520
	0.00 - 35.08
	


	Table 2. Girls

	Dataset
	 Sample size
	No occasions 
measurements
	Age range (yr)
	Measures

	Chard
	 137
	 1227
	8.32 - 16.61
	HT        WT

	Cambridge (1)
	 118
	 2169
	0.04 -  6.06
	SL         WT

	Cambridge (2)
	   94
	   231
	4.95 - 11.96
	HT        WT

	Edinburgh
	   74
	 2388
	0.00 - 21.5
	SL  HT  WT

	Eastbourne
	   52
	   314
	0.00 -  2.07
	SL

	Harpenden
	 257
	 3021
	0.90 - 30.13
	HT         WT

	ICC 
	   81
	 1641
	0.00 - 21.52
	SL  HT

	France
	 239
	 3685
	0.08 - 20.00
	SL  HT

	Total
	1052
	14676
	0.00 - 30.13
	

	
	
	
	
	

	Key to tables:

	ICC = International Children's' Centre study involving 6 Western European samples. Apart from the French sample the other data are from the U.K.

	HT = Height; SL = Supine length; WT = Weight

	


Appendix B: statistical methodology used in constructing longitudinal norms

This appendix provides a brief summary of the statistical methodology used to construct the norms used by LGROW. Full details are provided by Pan and Goldstein (1997).

Average velocity norms

For a short period of time, where growth does not depart markedly from a straight line, we can summarise growth adequately using the average velocity. For a set of standardised ‘Z’ scores, a measurement 
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, the velocity for two measurements on the 
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or we can alternatively estimate 
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 in the following linear model,
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Similarly, we assume a linear model where there are three or more  measurements.

Average Acceleration

Over a long period of time, average velocity may be of questionable value in the assessment of growth and a more complex function may be required. For three consecutive measurements on the 
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The first derivative of z gives the velocity and for the second derivative we obtain the average acceleration, 
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. The explicit formulae for the coefficients 
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 are more complicated than those of the linear model and in this case we use a simulation procedure to estimate the distributions of the velocity and acceleration. 

Conditional norms

Let 
[image: image47.wmf]z

1

 and 
[image: image48.wmf]z

2

 be SD scores for height at age 
[image: image49.wmf]t

1

 and 
[image: image50.wmf]t

2

 which are Normally distributed with means 
[image: image51.wmf]m

1

, 
[image: image52.wmf]m

2

,  variances 
[image: image53.wmf]s

1

2

 and 
[image: image54.wmf]s

2

2

 and correlation 
[image: image55.wmf]r

12

. The conditional distribution of 
[image: image56.wmf]z

2

 at age 
[image: image57.wmf]t

2

 given 
[image: image58.wmf]z

1

 at age 
[image: image59.wmf]t

1

 is


[image: image60.wmf]z

2

|
[image: image61.wmf]z

1

 ~ 
[image: image62.wmf]N
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More generally, we can use the formulae, for example from Kendall and Stuart (1961) for standardised multinormally distributed variables . Denote by 
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The corresponding conditional norms are then given by:
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where 
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 is the Normal equivalent deviate for tail area 
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Appendix C: Measurements at the approach to maturity 

In order to provide longitudinal norms for boys to 18 year and girls to 16 years, two separate model fits have been used for the range 3 months to 16 years and 14 years to 18 years for boys and for the range 3 months to 15 years and 12 years to 16 years for girls. As far as possible the models have been adjusted to provide the same results in the range of overlap and the results of extensive tests have shown this to be satisfactory. Where the ages all lie within one of  the above ranges there will be no problem. In some cases users may, however, notice a small discrepancy where one model has been used for a part of the range of ages and the other model for the remainder. This will be indicated by a message when running LGROW and further work on this issue will be incorporated into future releases of LGROW.
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